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I have to say that I’m not an expert in Photoshop and most likely some of the steps I’m presented here could be done 
easier or better. I’m currently using Photoshop CS4, but I will make this tutorial compatible at least with CS3 (in other 
words I’m not going to use all the shortcuts and specialties I have in CS4). I will explain each step in detail, so that 
beginners could follow it up as well, but later sections when I’m using the same techniques as earlier I will not 
explain them anymore. So in case you encounter a technique you don’t know how to perform, please refer 
backwards to find the paragraph where it was originally explained. 

I will start by making few things we need later in the tutorial; the ground, forest, mountain and rough textures. It is 
not absolutely necessary to make these textures and you can create good looking landscapes just by painting with 
solid colors, but having pre made textures saves time and many times gives better result that just drawing (this of 
course depend on your artistic skill and I’m just saying it on my own behalf). 

PREWORD and PREWORK 

Preparing the ground texture 
I have selected relatively simple ground texture. It was originally a grassland picture 
with yellow and green shades. I want to lower the amount of detail though and make 
it more peaceful with fewer colors. One fun way to do it is to use filter “cutout” 
(Filters -> Artistic -> Cutout). 

 
 

Making seamless textures 
In order to have a good looking background I either have to have the texture at least same size 
as my document or I have to make the texture seamless. To make the texture seamless I used 
Pattern maker –function (Filter -> Pattern maker) and here is the 
result (please note that this is just a small piece of the full texture 
and is therefore not seamless). 

 
 
 
 

Next thing is to create textures for mountains, forests, rough terrain, and rivers.  In all cases I already had a suitable 
texture and I just wanted to make them seamless. Here are the examples of the textures I’m going to us: 
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Enhancing the forest texture 
Next thing I’m going to do is really optional and you could use basic and solid forest texture and get a good looking 
result. But I want my forest here to have a “see through” effect where parts of the underlying ground can be seen 
through the forest. In this small example you can see 
what I mean and it will have spice up the final map. 

I don’t want to make my forest transparent, so I’m not 
going to lower the opacity at all. Instead I’m going to 
make really small random holes to the texture to see 
through.  

 

I will open my forest texture for edition and 
take the magic wand tool. I’m going to select 

the dark / black areas from my texture, so I set the tolerance to 
really low (2) as I don’t want to select all that is black. I start by 
selecting something that is black and right-click the selection to 
bring up the selection menu and select “similar”. Then you 
should have a lot of black / dark areas selected and you can 
press “delete” to make the holes. 
 

 
 

The forest pattern I have has too big trees, so I’m going to reduce the size of it to half of 
the original. 

 

 

 

 

 

 

Creating a town texture 
I’m going to create my towns as a mixture between symbolic and real looking towns. I started by drawing simple 
buildings from different angles. I didn’t have to worry about exact perspective or details as the final picture would be 
really small and the details (and mistakes) couldn’t be seen anyway.  

Then I just copy pasted the buildings to another document and filled the gaps between the houses. 
Finally I changed the image size as small as possible where I still could recognize the buildings.  

I couldn’t make this a seamless texture in the same way as before. I made it manually by coloring the 
opposite edges and checking once in a while by copy pasting the texture side by side into larger area. 
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Defining patterns 
Last step is to make patterns from our newly created textures by using the “define pattern” -feature  
(Edit -> Define pattern). By defining patterns we can select them later for layer styles and we can use the pattern as a 
brush etc. 
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In this part we start first by making the ground texture and then continue with creating the mountain range. Last but 
not least we will add forest over the mountains and see how we can get it to follow the “height” of the mountains. 

THE REAL DEAL 

Creating a new document 
Make a new document of any size you like. I’ll make it 700x500px as it fits nicely into my working area, but still is big 
enough for this mountain range I’m going to create here. Make sure the new document is 8-bit RGB. 

BACKGROUND 

Adding Clouds -layer 
Add a new layer and render some clouds to it (Filter -> render -> clouds). Remember to reset your 
foreground and background colors by pressing “D” before rendering clouds.  By doing this reset we make 
sure that we get the clouds in correct color. 

This layer is responsible for the bumpiness of the background, so if you want to have more highs and lows then you 
can create a temporary document with higher resolution and make the clouds there. Then just resize the clouds to fit 
you primary work document and paste the clouds there. That is just what I will do here, so I create a temporary 
document of 1400x1000px and render the clouds there. Then resize it to 700x500px and copy/paste it to my primary 
WIP. 

Adding Noise -layer 
Next step is to add a new layer on top and fill it with white color. Then 
create some black and white noise to it (Filter -> noise -> add noise).  You 
get black and white noise by clicking “monochromatic” tab at the bottom. 
Together with the Clouds –layer, 
noise is responsible for making 
the ground layer more realistic 
looking. 
And not to get too granular with 
the final result, we need to do 
some Gaussian blur to the noise 
(Filter -> Blur -> Gaussian blur). I 
will set the radius to 1,0 pixels 
(the bigger the radius the softer 
you get). 
 

Adding the Ground layer 
Adding 3rd layer to the top and filling it with ground texture created in the pre work 
phase. Then we need to change that layer type to “multiply”.  

Making the ground layer visible 
Next step is to lower the opacity of the clouds and noise layers to get the ground layer 
visible. This is can be done by selecting each layer and lowering the opacity percentage. 
I going to reduce mine to 20% in both Clouds and Noise layers, but the values depend 
on your own liking and the ground layer texture. 
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Roughing up the ground 
Now that we have the Ground layer visible, we can add effect to it to give it a bit of a rough look.  The effect can be 
added by double clicking the Ground layer and selecting the desired effect. From the new Layer Style -window, I’m 
going to select the styles “Bevel and Emboss” and “Texture” 
 
I put the Bevel size to 0 as I don’t want to have any bevel in background, but under texture -style I choose the rough 
pattern introduced in the pre work point. I don’t make any changes to the settings, but the scale and depth can be 
changed depending on the chosen texture. 

 

 

 
 

Finalizing the background 
Quite often the ground looks a bit too dark, so we want to lighten it up a bit. I will add a new adjustment layer (Layer 
-> Add New Adjustment -> Brightness/Contrast) and I’m going to leave the brightness intact and correct only the 
Contrast by 40. 
At this point you can also play with the opacity of the Clouds and Noise layers to find the best combination. 

Here you see the finalized background and 
for comparison the ground texture we 
started from.  

Adjustment layers can be added to an 
image to apply color and tonal 
adjustments without permanently 
changing the pixel values in the image. For 
example, if you add a Color Balance adjustment layer to an image, 
you can experiment with different colors repeatedly, because the 
change occurs only on the adjustment layer. If you decide to return 
to the original pixel values, you can hide or delete the adjustment 
layer. 



Version 1.5 by Pasi Soini Page 8 
 

We create the mountains in 3 different layers. In one layer we are going to have the lowest parts of the mountains, 
in the second we have the middle parts and in the top layer we will have the mountain peaks. The benefit of this 
technique is that you will be able to have different styles and effects on each layer making the mountains to really 
pop out. 

MOUNTAINS 

Setting up the mountain layers 
Let’s start by adding 3 new layers; mountains low, -med and –high.  On each layer we add effects to it (Bevel and 
emboss, Contour and Texture) to get a desired look.  There are no exactly right settings to use and you should 
experiment to find the best values for your mountains. You can even create different mountain types by creating 
another set of mountain layers with different settings and drawing some of your mountains to it. 

Low mountains -layer 
I will add few effects the same way as when we were roughing up the background to the “mountains low” -layer. I 
select the Bevel and Emboss, Contour and Texture effects. 

Bevel size should be set to low 
because high bevel would create too 
steep mountains. Instead of very 
steep mountains I want mine to build 
up gently and to blend well with the 
surrounding ground. I’ll use depth 
150%, size 5 and soften 0.  
 I will also lower the opacity of the 
highlight mode to 30%. This will 
reduce the glare of mountains. 

 

 

 
 
 
 
Then I set the Contour range to 30% (you get steeper and sharper pointed 
mountains by decreasing the contour). You can also select different 
contour type from the drop down menu, but I have used here the default 
linear contour. 
 
Next step is to select a texture for the mountains from the patterns I 
introduced in the pre work section. I will reduce the scale of the texture to 
50% as the pattern was too big for the mountains and didn’t look good. I 
will also reduce the depth of the pattern to 50% as other vice I would get 
too rough mountains. 
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Medium mountains –layer 
In the medium mountain 
layer I’m going leave the 
depth to 100% and have a 
higher bevel size (7 or 8) 

 I will also reduce the 
contour to 15% and for the 
texture; I will use the same 
settings as with low 
mountains.  

 

 

 

 

High mountains –layer 
I will set the effects for the 
mountain tops as well and 
here you can see the values 
I used. 

 

 

 

 

 

 

  

 
You can (and should) play with these settings and here we have two examples where the picture in left used the 
settings described above and in the right 
one I just changed the middle layer bevel 
depth to 200% and increased the Contour 
to 30%. Basically the only difference is that I 
get a bit rougher looking mountain, but 
kept the same shadow balance. The change 
is not big, but when this is applied to the 
whole mountain range it sure changes the 
feeling.  
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Raising the mountains 
We have just set the 3 mountain layers ready and now we start painting the mountains 
on them. We will paint with the pattern stamp tool and I will use the mountain pattern 

we created in the pre work phase. 

On the low level mountains layer 
you paint with large and very soft 
(100 – 200px) brush with 30-50% opacity and flow. In this layer you only roughly paint the area of your mountains. 

 

 
 
 

 

 

 

Then reduce the brush size to around 65px, increase the 
opacity to around 50% and paint to the medium mountains 
layer. The intention here is to paint the body of the mountains 
and you can select smaller and bigger brush sizes.  

 

 

 

 

Finally take even smaller and a bit harder brush and increase 
the opacity to 50-60%. Then paint the mountain peaks to the 
high mountains layer and one good way is to paint in the 
direction of the slopes. 

 

 

 

 

 

By painting many times over some parts and only once over some, you get great looking highs and slopes. 
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Adding the forest is a really simple thing and you get the forest following the height of the mountains automatically. 

FOREST 

First thing I will do is to add a new layer on top and name it to “Forest”. I’ll change the forest layer to multiply in 
order to get the forest to grow above the below ground. Then I put few effects (drop shadow and bevel) to the layer 

and we are good to go. 

Note that I have put the bevel 
shading highlight mode to 0%, 
because I don’t want my forest to 
have any highlight, only shadow. 
You can test what it does to add 
highlight and you will why I 
lowered it to 0. 

 

 

  
 

Planting forest 
Go to that new forest layer and select the pattern stamp tool with your forest as pattern. I choose a bit soft brush 
and set the opacity and flow to max (100%). While drawing I will change the brush size so that I can paint larger areas 
and small details.  

Here I have 2 samples. The first one just demonstrates how well the forest follows the height of the mountains and 
the second one is the actual forest I draw. 

 
 
 
 
 
 
 
 
 
 
 

Finalizing the forest 
In case you want to adjust your forest colors or make it brighter or something, just add 
suitable adjustment layer and create a clipping mask with forest layer. You can set the 
adjustment layer to clipping mask by right clicking the layer and selecting “create 
clipping mask” from the pop-up menu. 
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RIVERS AND LAKES 
Of course we need to have water in our world. The texture I introduced in pre work section is suitable for rivers and 
small lakes, but is not good enough for large water areas. So in case you plan to have large waters as well, remember 
to try out your textures in large areas in advance. 

Setting up the river layers 
I’ll add two layers for the rivers, one for the actual rivers and another one for 
river enhancements (adding current etc).  
I’ll add few effects (bevel and contour) to the Rivers –layer as well. I’ll change 
the direction of the bevel to “down” as I want the river to run lower than the 
surrounding ground. But then I put the bevel size to 0 and soften to 1 to keep 
the effect minimal. I’ll add contour to spice it up a bit. 
 
 
 
 
 

Painting the river 
I select the pattern stamp –tool and select the river pattern. I select small (3px) brush for 
the smaller rivers and start painting. I paint with full opacity as I’ll add some effects to it 
later and will not play with opacity at this point. I have two small rivers coming together 
making the river wider, so I’ll use 5px brush for the wider part.  

 
 
 
 
I will draw also a small lake with two small islands in it. I do the 
islands by first drawing the lake and then I’ll just remove small 
pieces of the lake with eraser tool and voila!  
 

As you paint you see that the river seem to flow over the forest, so we 
have to do something about that. There are two things I’m going to do.  
First I’ll remove the forest below the river. To do that I’ll go to the rivers 
layer and take the magic wand tool. Then I’ll select any area outside 
river and it now has selected everything else but the river. Right click 
your selection and from the pop-up menu choose “Select Inverse” and 
now you have the river selected. Then go to the forest layer and press 
“delete” to delete the forest under the river. 
Then we have to change the order of the river layer. I move the river 
layers above the mountain layers, but below the forest layer. The 

reason for this is that I want the 
rivers to be on top of the 
mountains, but I want the forest 
shadows to be cast over the 
river (if you remember we enabled the drop shadows while setting the forest 
layer). 
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Final touch on the rivers 
 The river starting point is too “strong” and it appears from nowhere, so I need to fade it. I do 
that simply by going to rivers layer and using eraser tool. I set the opacity of the eraser to about 
30% and start erasing the river starting point until it blends nicely. 
 
 
The final thing I’m going to do to my rivers is to add some 
running river feeling to them. I’ll do that with brush tool 
and white color (and with dark blue or even black). I set 
the brush opacity to about 30% and paint the final 
touches to the river enhancement –layer. By painting to a 
separate layer I don’t ruin my river by accident. 

 
 
 
 
 
…And here we have the final result… 
 
 
 
 
 
 
 
 
 

Managing layers 
As you can see we start to have quite many layers and to keep it more manageable I’ll 
group some layers. To group the layers I simply select all the layers I want to group and 
go to Layer -> New -> Group from Layers… Then you can close or open the groups as 
you need. 
I’m going to add groups for my background and for my mountains at this point and 
name them as “Ground” and “Mountains”. 
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Lakes and seas 
The lakes are done in the same way as the rivers by painting with 
the pattern stamp tool. To get a rough costal line I use “Rough 
Round Bristle” brush varying the brush size. But because the 
pattern I use is quite small it starts repeating itself annoyingly.  To 
overcome that I copy the Clouds –
layer I used while making the ground 
and paste it above the river layer. 
Then I change the opacity of that 
second cloud –layer to 30% and 
create clipping mask from it (so that 
it effects only to the rivers layer). 
The sea still looks a bit too pale, so 
I’ll add a new adjustment layer (hue and saturation) and make it clipping mask too. 

Coast line 
There are many ways to create coast line and 
the one I’m using here is really simple.  I just 
add new layer style to the sea layer called 
“inner glow”.  
If you have your rivers and sea in the same 
layer this will make the rivers quite white. To 
get rid of that annoyance you have 2 options. 

1) Make the rivers in separate layer. 
2) Add another layer on top of the sea 

and lower its opacity to around 50%. 
Then go to the sea layer and use 
magic wand to select all the sea and 
rivers. Go to the river corrections 
layer again and paint the rivers again 
with the sea texture. 

 

Alternative sea texture 
There are some really good looking water textures in the internet you can use. It is not always 
certain if the best looking texture is really the best as different map styles requires different 
textures. Anyway here is one alternative texture I tried and it actually gave a good look, but I 
had to make some small alterations to the settings.  As the texture is so strong I lowered the 
river layer opacity to 90% and increased the clouds layer opacity to 70%. Coastal line was now 

too invisible, so I increased its opacity to 
60%. Finally I changed the adjustment layer properties 
(Hue:+2, Saturation:-1 and Lightness:+20). 
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There are not too many tricks to do in the roads so it becomes important to make the roads to follow the natural 
paths of your world. In short it means that make the roads go the easiest reasonable path and not over the highest 
mountain. 

ROADS, TOWNS AND FIELDS 

Setting up the roads layers 
Roads will be built into their own layer as usual and the layer should be above the mountains and rivers, but below 
the forest. I will have my roads layer set to multiply and no special effects. As the layer is set to multiply, the roads 
will get “texture” from the underlying ground. But in case you have smaller scale map with wider roads, you might 
need to add a texture to your roads. 

Painting the roads 
There is nothing special in painting the roads. I just select a basic brush 3px wide and let it go. You can choose either 
brown or gray roads whatever suits bets for your map. 
You should do the same thing with roads as you did with water by deleting the forest under the roads.  Then you 
need bridges and one simple way is to draw the bridge outlines with dark color. 

Setting up the towns layers 
I’m going to have my towns as a mixture between symbolic and real looking towns. The scale of my map is so big that 
it would be hard to draw the towns in real size and look anyway. I will have my towns in own layer (as usual) and just 
above the roads layer.  

I want to spice up the towns and add a bit 
more 3D-look. So I’ll add a drop shadow 
and to get the individual houses to pop up I 
will select the town pattern and set the 
depth to 150%. The town became a bit too 
dark, so I also added an adjustment layer 
above the town layer and made it a clipping 
mask with town layer. 

 
 
 
  
 

Painting the town 
I paint the town just by selecting pattern stamp tool and selecting town pattern. I set moderately hard brush as I 
don’t want any blending effect. 

When the town is in place you can create fortifications around it if you like. One easy way is to use magic wand and 
select everything else but the town and then select -> modify -> border (with border value 2). Now I have 2 px wide 
border selection around my city and I can paint my walls without going 
overboard. When done I add few towers just by painting few blocks to the 
wall with 5px wide brush. 
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Fields 
It is not necessary to add fields near the town and it depends also your scale if fields should be added.  But I’ll add 
them here as a nice detail. 

Creating the fields texture 
I create the field texture just by drawing vertical and horizontal squares in yellow, brown and 
grey into a separate small document. Then I’ll use the pattern maker tool to make the texture 
seamless. It now requires manual improvements in the center of the fields as the pattern maker 
tool didn’t do the work optimally (but don’t touch the document edges as they are now made 
seamless). 

Then I’ll add few adjustment layers (contrast and hue/saturation) and adjust the right balance. Because I used brush 
to draw the fields it is a bit blurry, so I want to sharpen the texture a bit (Filter -> Sharpen -> Sharpen). 

Last thing is to make a pattern out from our new fields texture the same way as before. 

Setting up the fields layer 
I will add a new layer and call it “fields” and put it right below the towns -layer. I will not add any special effect here 

Drawing the fields 
I draw the fields using pattern stamp tool and the newly created pattern. I use small brush 5-
13px and draw with full opacity and flow. 

The fields seem to be still a bit too light, so I’ll add a new adjustment layer (brightness and 
contrast) and make it clip with the Fields –layer. Then I decrease the brightness and add 
contrast to get desired result. 
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FINAL TOUCH 

The final thing I’m going to do is to add 
some handmade hills. First I add a new layer 
below the ground layer and name it to Hills. 

Then I set few effects as per screenshots 
(using the same texture as with the 
mountains) and start painting with quite 
small brush (5-20px). I choose tan brown 
and set the opacity to 30, but you can get 
more rocky feeling with grayish color. 

Here you can see that it really gives a good   
look to this. 

And remember to draw the rough terrain under the forest too to 
prevent the forest from looking flat.  

 

 

 

 

 

I will also add some grass and some additional variations to spice things up a bit more. So I add two more layers 
above the ground layer (Grass and Harsh) but these are not necessarily needed if your ground texture has enough 
variation. I will not have any special effects on these new layers as I just use them to add color variation, but I set the 
layer type to multiply. I do these on separate layers as its non destructive way and you can easily click the layers on 
and off to decide if you like it or not. 

For the harsh ground I will use pattern stamp tool with the rough terrain texture introduced in the pre work section. 
Then I set the opacity and fill to about 35% and start painting. I paint over some hills with smaller brush and some 
ground areas with larger brush to get kind of barren feeling to it. And of course when painting many times over the 
same area will increase the effect. 

For the grass I use 5-35px wide soft brush and 30% opacity/fill. Then I just select some dark green and start painting 
the grass. 

  Original       Harsh texture added        Grass added 

 



Version 1.5 by Pasi Soini Page 18 
 

If you don’t want to paint your grass manually and you are willing to give up the control of placing the grass exactly 
where you want, you can use some suitable additional texture and paint with that. In order to get the grass looking 
got I will add a new layer on top of the ground layer and set its type to “hard light”. The effect is a bit too hard, so I 
lower the flow to 75%. 

I will use the following texture and the outcome is really nice. 

                 Before: 

 

 

 

 
 
 

                       After: 

 

 

 

LABELING 

There are thousands of different fonts and choosing one can be hard and the outcome to the general feeling of the 
map can be huge. So I’m not going to say what font to use as there is no right answer, but there are some tricks to 
make the text more readable and better looking. 

At first I have to say that Photoshop is not the best software to use for labeling, but I’m going to stick with just one 
software in this tutorial. 

Black is usually the best color to use, but other colors could be used of course. Usually bright colors should be 
avoided as they are generally hard to read and often they go overboard when considering the overall coloring 
scheme of the map. You should also stick with only one font and other fonts should be used only when showing 
something different like country names or political factors. Even all this said these are just my opinions and you 
should use your own judgment on this matter.  

In this example I use only black font and couple of layer styles to make them more eye appealing and readable. I use 
drop shadow layer style on each label and outer glow in the ones in need of improved readability. 

Drop shadow only  Drop shadow + outer glow 
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